The CC3220 device is part of the SimpleLink™ microcontroller (MCU) platform which consists of Wi-Fi®, Bluetooth® low energy, Sub-1 GHz, and host MCUs. All share a common, easy-to-use development environment with a single core software development kit (SDK) and rich tool set. A one-time integration of the SimpleLink platform lets you add any combination of devices from the portfolio into your design. The ultimate goal of the SimpleLink platform is to achieve 100 percent code reuse when your design requirements change. For more information, visit www.ti.com/simplelink.

The CC3220 SimpleLink LaunchPad™ development kit (CC3220-LAUNCHXL) is a low-cost evaluation platform for Arm® Cortex®-M4-based MCUs. The LaunchPad kit design highlights the CC3220 Internet-on-a-chip™ solution and Wi-Fi capabilities. The CC3220 LaunchPad kit also features temperature and accelerometer sensors, programmable user buttons, three LEDs for custom applications, and onboard emulation for debugging. The stackable headers of the CC3220 LaunchPad XL interface demonstrate how easy it is to expand the functionality of the LaunchPad kit when interfacing with other peripherals on many existing BoosterPack™ plug-in module add-on boards, such as graphical displays, audio codecs, antenna selection, environmental sensing, and more.

*Figure 1* shows the CC3220 LaunchPad development kit.

*Figure 1. CC3220 SimpleLink Wi-Fi LaunchPad Development Kit*
## Contents

1 Introduction ................................................................................................................... 4
   1.1 CC3220 LaunchPad Development Kit ................................................................. 4
   1.2 Key Features ........................................................................................................... 5
   1.3 What's Included ..................................................................................................... 5
   1.4 Regulatory Compliance ......................................................................................... 5
   1.5 First Steps: Out-of-Box Experience .................................................................... 5
   1.6 Next Steps: Looking into the Provided Code ....................................................... 6

2 Hardware Description ........................................................................................................ 7
   2.1 Block Diagram ....................................................................................................... 8
   2.2 Hardware Features ............................................................................................... 8
   2.3 Connecting a BoosterPack Plug-in Module .......................................................... 9
   2.4 XDS110-Based JTAG Emulator .......................................................................... 10
   2.5 Wired Connections, Jumper Settings, Buttons, and LEDs ................................... 10
   2.6 Power ................................................................................................................... 20
   2.7 Isolated Current Measurement of the CC3220 ..................................................... 23
   2.8 RF Connections ................................................................................................... 25
   2.9 Assembly Drawing .............................................................................................. 26
   2.10 Design Files ....................................................................................................... 27
   2.11 Software ............................................................................................................ 27

3 Development Environment Requirements ....................................................................... 27
   3.1 CCS IDE .............................................................................................................. 27
   3.2 IAR IDE ............................................................................................................... 27

4 Additional Resources ...................................................................................................... 27
   4.1 CC3220 Product Page ......................................................................................... 27
   4.2 LaunchPad Development Kit Wiki ..................................................................... 27
   4.3 Download a Development Environment ............................................................ 28
   4.4 SimpleLink™ Academy for CC3220 SDK ......................................................... 28
   4.5 Support Resources .............................................................................................. 28

---

### List of Figures

1 CC3220 SimpleLink Wi-Fi LaunchPad Development Kit ................................................ 1
2 WEEE Statement ........................................................................................................ 4
3 CC3220 LaunchPad Development Kit Overview .......................................................... 7
4 CC3220 Block Diagram ............................................................................................. 8
5 Pin 1 Marking on CC3220LP (3V3 Tag) ................................................................... 9
6 XDS-110 Debug Probe ............................................................................................. 10
7 Default Jumper Configuration for JTAG Lines .......................................................... 10
8 JTAG IN Connector (J8) .......................................................................................... 11
9 XDS110 OUT Connector (J4) .................................................................................. 12
10 I2C Bus Connections ............................................................................................. 13
11 Power Jumpers J14, J21, J20, J19, J17, and J18 ..................................................... 14
12 SOP Jumpers (Default Setting Shown) ................................................................... 16
13 UART Routed to USB COM Port ........................................................................... 17
14 UART Routed to 20-Pin Header Connector .............................................................. 17
15 CC3220 BoosterPack Module Header Pin Assignments .......................................... 19
16 Powering From USB Jumper Settings .................................................................... 20
17 Powering the CC3220LP From Battery ................................................................. 21
18 Only CC3220 and Serial Flash Powered by Battery .............................................. 22
19 Low-Current Measurement (<1 mA) ...................................................................... 23
20 Active Power Measurements (>1 mA) ..................................................................... 24
21 Using Onboard Antenna (Default Condition) ......................................................... 25

---

CC3220 SimpleLink™ Wi-Fi® LaunchPad™ Development Kit Hardware

SWRU463C—February 2017—Revised March 2020

Copyright © 2017–2020, Texas Instruments Incorporated

Submit Documentation Feedback
List of Tables

1  JTAG Header Pin Definitions ................................................................. 11
2  I²C Jumper Definitions ........................................................................... 13
3  Default I²C Addresses (of Onboard Sensors) .............................................. 14
4  Jumper Settings for LaunchPad Kit Power .................................................... 15
5  External Supply Connections and LED Enable Jumper ................................. 15
6  Reset Pullup Jumper .................................................................................. 15
7  SOP[2:0] (J13 on LaunchPad Kit) ................................................................. 16
8  Push-Button Definitions ............................................................................. 18
9  LED Indicators .......................................................................................... 18

Trademarks
SimpleLink, LaunchPad, Internet-on-a chip, BoosterPack, Code Composer Studio, Tiva, E2E are trademarks of Texas Instruments.
Arm, Cortex are registered trademarks of Arm Limited.
Bluetooth is a registered trademark of Bluetooth SIG.
IAR Embedded Workbench is a registered trademark of IAR Systems AB.
Wi-Fi is a registered trademark of Wi-Fi Alliance.
All other trademarks are the property of their respective owners.
1 Introduction

1.1 CC3220 LaunchPad Development Kit

Created for the Internet of Things (IoT), the SimpleLink Wi-Fi CC3220 device is a single-chip microcontroller (MCU) with built-in Wi-Fi connectivity for the LaunchPad ecosystem, which integrates a high-performance Arm Cortex-M4 MCU and lets customers develop an entire application with one device. With on-chip Wi-Fi, Internet, and robust security protocols, no prior Wi-Fi experience is required for fast development.

The CC3220 LaunchPad kit, referred to by its part number CC3220-LAUNCHXL, is a low-cost evaluation platform for Arm Cortex-M4-based MCUs. The LaunchPad kit design highlights the CC3220 Internet-on-a-chip solution and Wi-Fi capabilities. The CC3220 LaunchPad kit also features temperature and accelerometer sensors, programmable user buttons, three LEDs for custom applications, and onboard emulation for debugging. The stackable headers of the CC3220 LaunchPad XL interface demonstrate how easy it is to expand the functionality of the LaunchPad kit when interfacing with other peripherals on many existing BoosterPack add-on boards, such as graphical displays, audio codecs, antenna selection, environmental sensing, and more. Figure 3 shows the CC3220 LaunchPad kit. There are two variants of the LaunchPad kit: the CC3220S-LAUNCHXL and the CC3220SF-LAUNCHXL. This user's guide applies to both variants, and any differences are pointed out in relevant sections.

Multiple development environment tools are also available, including TI's Eclipse-based Code Composer Studio™ (CCS) integrated development environment (IDE) and IAR Embedded Workbench®. More information about the LaunchPad kit, the supported BoosterPack modules, and the available resources can be found at TI's LaunchPad portal. Also visit the CC3220 Wiki page for design resources and example projects.

---

NOTE: The maximum RF power transmitted in each WLAN 2.4-GHz band is 17.5 dBM (EIRP power).

NOTE: The antennas used for this transmitter must be installed to provide a separation distance of at least 20 cm from all persons, and must not be colocated or operating in conjunction with any other antenna or transmitter.

NOTE: All figures and references in this document apply to RevA and RevB. Most of the document also applies to higher revisions, unless otherwise stated.

---

Waste Electrical and Electronic Equipment (WEEE)

This symbol means that according to local laws and regulations your product and/or its battery shall be disposed of separately from household waste. When this product reaches its end of life, take it to a collection point designated by local authorities. Proper recycling of your product will protect human health and the environment.

---

Figure 2. WEEE Statement
1.2 Key Features

- CC3220S/SF, SimpleLink Wi-Fi, Internet-on-a chip solution with integrated MCU
- 40-pin LaunchPad standard that leverages the BoosterPack ecosystem
- XDS110-based JTAG emulation with serial port for flash programming
- Two buttons and three LEDs for user interaction
- Back-channel universal asynchronous receiver/transmitter (UART) through USB to PC
- Onboard chip antenna with U.FL for conducted testing
- Onboard accelerometer and temperature sensor for Out-of-Box Experience (OOBE)
- Micro USB connector for power and debug connections

1.3 What’s Included

1.3.1 Kit Contents

- CC3220 LaunchPad development tool (CC3220S-LAUNCHXL or CC3220SF-LAUNCHXL)
- Micro USB cable
- Quick start guide

1.3.2 Software Examples

- Out-of-Box Software

1.4 Regulatory Compliance

The SimpleLink CC3220 Wi-Fi LaunchPad kit is tested for and found to be in compliance with FCC and ISED regulations regarding unlicensed intentional radiators.

Hereby, Texas Instruments Inc. declares that the radio equipment type CC3220S-LAUNCHXL and CC3220SF-LAUNCHXL are in compliance with Directive 2014/53/EU. The full text of the EU declaration of conformity is available at the following internet addresses:

- CC3220S-LAUNCHXL
- CC3220SF-LAUNCHXL

1.5 First Steps: Out-of-Box Experience

An easy way to get started with the EVM is by using its preprogrammed out-of-box code. It demonstrates some key features of the EVM.

1.5.1 Connecting to the Computer

Connect the LaunchPad development kit by connecting the included USB cable to a computer. A red power LED should illuminate. For proper operation, the SimpleLink drivers and Service Pack from the CC3220 Software Development Kit (SDK) are needed. The SDK is available at www.ti.com/tool/SIMPLELINK-CC3220-SDK.
1.5.2 Running the Out-of-Box Experience

The CC3220 LaunchPad development kit's Out-of-Box Experience (OOBE) demonstrates and highlights the following features:

• Easy connection to the CC3220 LaunchPad kit:
  – Using the SimpleLink Wi-Fi Starter Pro application (available on iOS and Android™), users can use Access Point (AP) provisioning or SmartConfig™ provisioning for a fast CC3220 connection.
  – Configuring the device in AP mode gives users a direct connection to the CC3220 LaunchPad kit. Once the device is provisioned and connected to an AP in station mode, the profile is stored on the local file system so that any reset to the CC3220 automatically connects it to the AP.

• Easy access to the CC3220 through its internal web server, using either:
  – The SimpleLink Wi-Fi Starter Pro application
  – Any browser; web pages stored on the serial flash are loaded on the browser, to provide ease of use.

  This feature demonstrates configuring and reading onboard sensors.

• Over-The-Air (OTA) updates that demonstrate an update of a full image. OTA service enables in-system updates of the MCU application, CC3220 firmware releases (Service Pack) made available by TI, and other vendor files. An update procedure executed in a full-system integrity fashion, such as failure to upgrade any image components, results in rolling back to the previous valid version.

See the CC3220 LaunchPad Out-of-Box User's Guide for more details on the Out-of-Box Experience.

1.6 Next Steps: Looking into the Provided Code

After the EVM features have been explored, the user can open an integrated development environment and start editing the code examples from the SDK. See Section 4.3 for available IDEs and where to download them. The Out-of-Box source code and more code examples are provided in the CC3220 SDK. Code is licensed under BSD, and TI encourages reuse and modifications to fit specific needs.

With the onboard XDS110 debug probe, debugging and downloading new code is simple. A USB connection between the EVM and a PC through the provided USB cable is all that is needed.
2 Hardware Description

Figure 3 shows the CC3220 LaunchPad kit.

Figure 3. CC3220 LaunchPad Development Kit Overview

Jumper Isolation Block
- Power
  - GND, 5V, and 3V3
- Back-channel UART to the PC
  - RXD, TXD
- JTAG/SBW debug
  - SBWTDO/SBWTCK

Enable OPAMP Power

Button/Switch
SW2

CC3220 Microcontroller

U.FL Connector

Sensor Pullups

Chip Antenna

Reset SW1

Product Variant Label

Onboard XDS110 JTAG Emulator
Enables debugging/programming as well as communication back to the PC. The onboard emulator can also provide power to the target MCU.

Factory Reset Button
SW4

Button/Switch
SW3

40-pin BoosterPack plug-in module connector
(J1 - J4)

Reset Pullup Enable

Enable LED Power

User LEDs
2.2 Hardware Features

- CC3220S/SF, SimpleLink Wi-Fi, Internet-on-a chip solution with integrated MCU
- 40-pin LaunchPad standard that leverages the BoosterPack ecosystem
- TI Standard XDS110-based JTAG emulation with serial port for flash programming
- Supports both 4-wire JTAG and 2-wire SWD
- Two buttons and three LEDs for user interaction
- Back-channel universal asynchronous receiver/transmitter (UART) through USB to PC
- Onboard chip antenna with U.FL for conducted testing selectable using 0-Ω resistors
- Onboard accelerometer and temperature sensor for Out-of-Box Experience, with option to isolate them from the inter-integrated circuit (I2C) bus
- Micro USB connector for power and debug connections
- Headers for current measurement and external JTAG connection with an option to use the onboard XDS110 to debug customer platforms
- Bus-powered device, with no external power required for Wi-Fi
- Long-range transmission with a highly optimized antenna (200-meter typical in open air with a 6-dBi antenna AP)
- Can be powered externally, working down to 2.3 V (typical)
2.3 **Connecting a BoosterPack Plug-in Module**

A compatible BoosterPack module can be stacked on top of the LaunchPad kit using the 2-pin × 20-pin connectors. The connectors do not have a key to prevent the misalignment of the pins or reverse connection.

Ensure that the VCC and 5-V pins are aligned with the BoosterPack module header pins. On the CC3220 LaunchPad kit, a small white 3V3 tag symbol is provided near pin 1 (see **Figure 5**) to orient all BoosterPack modules. This same marking, provided on compatible BoosterPack modules, must be aligned before powering up the boards.

![Figure 5. Pin 1 Marking on CC3220LP (3V3 Tag)](image-url)
2.4  **XDS110-Based JTAG Emulator**

To keep development easy and cost effective, TI's LaunchPad development kits integrate an onboard debug probe, which eliminates the need for expensive programmers. The CC3220 LaunchPad kit has the XDS-110-based debug probe (see Figure 6), which is a simple and low-cost debugger that supports nearly all TI Arm device derivatives.

![Figure 6. XDS-110 Debug Probe](image)

2.5  **Wired Connections, Jumper Settings, Buttons, and LEDs**

2.5.1  **JTAG Headers**

The headers are provided on the board to isolate the CC3220 device from the onboard XDS110-based JTAG emulator. These jumpers are shorted by default when the board is shipped from TI. Figure 7 and Table 1 are for default configurations, and Figure 8 shows the external emulator connection.

![Figure 7. Default Jumper Configuration for JTAG Lines](image)
Table 1. JTAG Header Pin Definitions

<table>
<thead>
<tr>
<th>Reference (Rev. A/C)</th>
<th>Reference (Rev. B)</th>
<th>Use</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>J3 (TCK)</td>
<td>J8 (TCK)</td>
<td>JTAG / SWD</td>
<td>Jumpers populated: onboard emulator connected</td>
</tr>
<tr>
<td>J3 (TMS)</td>
<td>J8 (TMS)</td>
<td>JTAG / SWD</td>
<td>Jumpers not populated: onboard emulator disconnected</td>
</tr>
<tr>
<td>J3 (TDI)</td>
<td>J8 (TDI)</td>
<td>JTAG</td>
<td></td>
</tr>
</tbody>
</table>

(1) The only difference between Rev. A and Rev. B are the reference designators on the board.
(2) For SWD mode, the TCK and TMS headers must be shorted.

To connect an external emulator, remove these jumpers and place the external emulator on the JTAG IN connector.

Figure 8. JTAG IN Connector (J8)
2.5.2 Using the XDS110 Debug Probe With a Different Target

The XDS110 debug probe on the LaunchPad development kit can interface to most Arm Cortex-M devices, not just the onboard target CC3220 device. This functionality is enabled by the J4 10-pin Cortex-M JTAG connector (See Figure 9) and a 10-pin cable, such as the FFSD-05-D-06.00-01-N (sold separately from the LaunchPad development kit).

![Figure 9. XDS110 OUT Connector (J4)](image)

Header J4 follows the Cortex-M Arm standard; however, pin 1 is not a voltage sense pin. The XDS110 outputs only 3.3-V JTAG signals. If another voltage level is needed, the user must provide level shifters to translate the JTAG signal voltages.

1. Remove jumpers on the JTAG signals on the isolation block, including RST, TMS, TCK, TDO, and TDI.
2. Plug the 10-pin cable into J4, and connect to an external target.
   a. J4 follows the Arm Cortex Debug Connector standard outlined in [Cortex-M Debug Connectors](#).
3. Plug USB power into the LaunchPad development kit, or power it externally.
   a. JTAG levels are 3.3-V ONLY
### 2.5.3 I2C Connections

The board features an accelerometer and a temperature sensor for the out-of-box demo. These are connected to the I2C bus, and can be isolated using the jumpers provided (shown as yellow jumpers J15 and J16 in Figure 10).

![Figure 10. I2C Bus Connections](image)

By removing J15 and J16, the accelerometer and the temperature sensors are isolated from the I2C bus. This measure also removes the I2C pullup resistors from the sensor side of the circuit, and therefore any connection to the circuit requires the user to install external pullup resistors.

Table 2 lists the I2C jumper definitions.

<table>
<thead>
<tr>
<th>Reference (Rev. A/C)</th>
<th>Reference (Rev. B)</th>
<th>Use</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>J16</td>
<td>J2</td>
<td>I2C SDA</td>
<td>Populated: CC3220 SDA connected to onboard sensors with pullup</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Open: CC3220 SDA disconnected from onboard sensors</td>
</tr>
<tr>
<td>J15</td>
<td>J3</td>
<td>I2C SCL</td>
<td>Populated: CC3220 SCL connected to onboard sensors with pullup</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Open: CC3220 SCL disconnected from onboard sensors</td>
</tr>
</tbody>
</table>
2.5.3.1 Default I²C Addresses

Table 3 lists the default I²C addresses of the onboard sensors.

<table>
<thead>
<tr>
<th>Sensor Type</th>
<th>Reference Designator on LP (Rev. A/C)</th>
<th>Reference Designator on LP (Rev. B)</th>
<th>Part Number (Manufacturer)</th>
<th>Default Slave Address (Hex)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature (MEMS IR Thermopile)</td>
<td>U10</td>
<td>U6</td>
<td>TMP116⁽¹⁾ (TI)</td>
<td>0x49</td>
</tr>
<tr>
<td>Accelerometer (Triaxial)</td>
<td>U11</td>
<td>U10</td>
<td>BMA222E (Bosch)</td>
<td>0x18</td>
</tr>
</tbody>
</table>

⁽¹⁾ The TMP116 on Rev. C LaunchPad kits replaced the TMP006 (slave address: 0x41) on Rev. A and B.

2.5.4 Power Connections

The board can be powered by using the onboard micro USB connector. An onboard DC-DC converter provides 3.3 V for the CC3220 and the rest of the board to operate. This supply can be isolated from the DC-DC using the jumpers on the board. See the yellow jumpers in Figure 11.

Figure 11. Power Jumpers J14, J21, J20, J19, J17, and J18

NOTE: The blue jumpers in Figure 11 are previously discussed (see Section 2.5.1) and are populated by default. Figure 11 does not show unpopulated jumpers (which would be populated normally).
Table 4 lists the jumper settings for the LaunchPad kit power.

### Table 4. Jumper Settings for LaunchPad Kit Power

<table>
<thead>
<tr>
<th>Reference (Rev. A)</th>
<th>Reference (Rev. B)</th>
<th>Use</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>J14</td>
<td>J5</td>
<td>OPAMP EN</td>
<td>If the jumper is uninstalled, the power supply to the OPAMP is cut off. This can be used to enable low-current measurements. Ensure that this jumper is on to use the OPAMP to drive the input to the ADC. The reference voltage of the ADC is 1.47 V, so up to 3.48 V can be applied to the input of the OPAMP. For the configuration of the OPAMP, see the CC3220 LaunchPad Kit Design Files.</td>
</tr>
<tr>
<td>J21</td>
<td>J10</td>
<td>GND</td>
<td>Ground reference</td>
</tr>
<tr>
<td>J20</td>
<td>J29</td>
<td>+5 VDC power jumper</td>
<td>Connects J19, +5 VDC to emulator section</td>
</tr>
<tr>
<td>J19</td>
<td>J12</td>
<td>Current measurement</td>
<td>Measures the current flowing into the CC3220 device and the serial flash.</td>
</tr>
<tr>
<td>J17</td>
<td>J13</td>
<td>Board power</td>
<td>Short: Supply the board power from the onboard DC-DC converter. The board power includes the sensors, LED, and the OPAMP used to drive the ADC input.</td>
</tr>
<tr>
<td>J18</td>
<td>J28</td>
<td>VSENSE</td>
<td>Used to power the level shifters on the emulator side of the board. The level shifters can be powered by shorting this jumper. Removing this jumper enables low-current measurement.</td>
</tr>
</tbody>
</table>

The board can be powered by an external supply when USB power is not available, by using either J22 or J23. J24 is also available to remove any current draw from LEDs being driven by the GPIOs, see Table 5.

### Table 5. External Supply Connections and LED Enable Jumper

<table>
<thead>
<tr>
<th>Reference (Rev. A/C)</th>
<th>Reference (Rev. B)</th>
<th>Use</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>J19</td>
<td>J12</td>
<td>Alternative 3.3-V power input</td>
<td>Can be used to power the board from an external 3.3-V supply; this can be used to test the VBAT voltage range as the reverse voltage protection diode on J22 drops the input by approximately 150 mV.</td>
</tr>
<tr>
<td>J23</td>
<td>J19</td>
<td>5-V power input</td>
<td>Used to power the board from an external 5-V supply.</td>
</tr>
<tr>
<td>J22</td>
<td>J20</td>
<td>3.3-V power input</td>
<td>Used to power the board from an external 3.3-V supply. J22 has built-in reverse voltage protection to prevent the battery from being plugged in the reverse manner.</td>
</tr>
<tr>
<td>J24</td>
<td>J9</td>
<td>LED EN</td>
<td>If uninstalled, the LEDs connected to the GPIO are disabled; this can be used to enable low-power measurements.</td>
</tr>
</tbody>
</table>

#### 2.5.5 Reset Pullup Jumper

Table 6 lists the reset pullup jumper.

### Table 6. Reset Pullup Jumper

<table>
<thead>
<tr>
<th>Reference (Rev. A/C)</th>
<th>Reference (Rev. B)</th>
<th>Use</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>J9</td>
<td>J26</td>
<td>RESET pullup</td>
<td>Install this jumper to enable the pullup resistor on the nRESET pin of the device, when the board is powered from an external supply.</td>
</tr>
</tbody>
</table>
2.5.6 Sense on Power (SOP)

The CC3220 can be set to operate in four different modes, based on the state of the sense-on-power (SOP) lines. These SOP lines are pins 21, 34, and 35 on the CC3220 device. Table 7 describes the state of the device, and Figure 12 shows the SOP jumpers.

Table 7. SOP[2:0] (J13 on LaunchPad Kit)

<table>
<thead>
<tr>
<th>Binary Value</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>000</td>
<td>Functional mode and 4-wire JTAG</td>
</tr>
<tr>
<td>001</td>
<td>Functional mode and 2-wire JTAG</td>
</tr>
<tr>
<td>010</td>
<td>Functional mode and flash programming</td>
</tr>
<tr>
<td>011</td>
<td>Factory default</td>
</tr>
<tr>
<td>100</td>
<td>Flash programming</td>
</tr>
</tbody>
</table>

Figure 12. SOP Jumpers (Default Setting Shown)

**NOTE:** SOP[2:0] corresponds to J13 in the LaunchPad kit schematic design.

**NOTE:** No jumpers on the block ensure that the line is pulled low using 100-kΩ pulldown resistors. Placing the jumper pulls the pin high using a 270-Ω resistor.
2.5.7 UART Signals

The board supports a USB-based virtual COM port, using the Tiva™ Arm MCU. The LaunchPad kit is shipped with the UART lines from the CC3220 connected to the UART on the Tiva MCU. The CC3220 UART TX can also be routed to the 20-pin connector for use as a GPIO or external UART. The selection is performed using jumpers on the board. The RX signal cannot be routed to the 20 pin connector because it is interfaced to an op-amp to use with an ADC. To use the pin as GPIO or external UART you must use the second pin on the J6 column.

Figure 13 shows the UART routed to USB COM port and Figure 14 shows the UART routed to 20-pin header connector.
2.5.8 Push-Buttons and LED Indicators

Table 8 list the push-button definitions.

Table 8. Push-Button Definitions

<table>
<thead>
<tr>
<th>Reference (Rev. A/C)</th>
<th>Reference (Rev. B)</th>
<th>Use</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW1</td>
<td>SW1</td>
<td>RESET</td>
<td>This is used to reset the CC3220 device. This signal is also output on the 20-pin connector to reset any external BoosterPack module which may be stacked. The reset can be isolated using the jumper block at the center of the board.</td>
</tr>
<tr>
<td>SW2</td>
<td>SW3</td>
<td>GPIO_13</td>
<td>When pushed, GPIO_13 is pulled to VCC.</td>
</tr>
<tr>
<td>SW3</td>
<td>SW2</td>
<td>GPIO_22</td>
<td>When pushed, GPIO_22 is pulled to VCC.</td>
</tr>
<tr>
<td>SW4</td>
<td>SW4</td>
<td>Factory default</td>
<td>Pressing this button and toggling RESET restores the factory default image on the serial flash. This can be used to recover a corrupted serial flash, provided the s-flash was programmed with a recovery image.</td>
</tr>
</tbody>
</table>

Table 9 lists the LED indicators.

Table 9. LED Indicators

<table>
<thead>
<tr>
<th>Reference (Rev. A/C)</th>
<th>Reference (Rev. B)</th>
<th>Color</th>
<th>Use</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1, D2</td>
<td>D2, D9</td>
<td>Green and Red</td>
<td>Debug</td>
<td>Indicates the state of the JTAG emulator. For TI use only.</td>
</tr>
<tr>
<td>D3</td>
<td>D1</td>
<td>Yellow</td>
<td>nRESET</td>
<td>Indicates the state of the nRESET pin. If this LED is on, the device is functional.</td>
</tr>
<tr>
<td>D6</td>
<td>D8</td>
<td>Red</td>
<td>Factory Reset</td>
<td>Indicates that the push-button for the factory reset is pressed.</td>
</tr>
<tr>
<td>D7</td>
<td>D4</td>
<td>Red</td>
<td>Power</td>
<td>Indicates when the 3.3-V power is supplied to the board.</td>
</tr>
<tr>
<td>D8</td>
<td>D5</td>
<td>Green</td>
<td>GPIO_11(1)</td>
<td>On when the GPIO is logic-1.</td>
</tr>
<tr>
<td>D9</td>
<td>D6</td>
<td>Yellow</td>
<td>GPIO_10(1)</td>
<td>On when the GPIO is logic-1.</td>
</tr>
<tr>
<td>D10</td>
<td>D7</td>
<td>Red</td>
<td>GPIO_09</td>
<td>On when the GPIO is logic-1.</td>
</tr>
</tbody>
</table>

(1) GPIO_10 and GPIO_11 are also used as I2C. Thus, when the pullup resistors are enabled, the LEDs are on by default, without configuring the GPIOs.
The TI BoosterPack module header pinout specification is at Build Your Own BoosterPack. Also see the BoosterPack Pinout Standard. The CC3220 LaunchPad kit follows this standard, with the exception of naming. (P1:P4 is used instead of J1:J4.) See Figure 15 for CC3220 pin-mapping assignments and functions.

**Figure 15. CC3220 BoosterPack Module Header Pin Assignments**

---

**NOTE:**

RESET output is an open-drain-type output and can only drive the pin low. The pullup ensures that the line is pulled back high when the button is released. No external BoosterPack module can drive this pin low.

All the signals are referred to by the pin number in the SDK; Figure 15 shows the default mappings. Some of the pins are repeated across the connector. For instance, pin 62 is available on P1 and P4, but only P1 is connected by default. The signal on P4 is marked with an asterisk (*) to signify that it is not connected by default. The signal can be routed to the pin by using a 0-Ω resistor in the path. For the exact resistor placement, see the CC3220 SimpleLink Wi-Fi Wireless MCU LaunchPad Board Design Files.
2.6  Power

2.6.1  USB Power

The LaunchPad kit is designed to work from the USB-provided power supply. The LaunchPad kit provides addresses as a bus-powered device on the computer. To power the CC3220 device from the USB, the jumpers must be placed on the following headers, as shown in Figure 16.

![Figure 16. Powering From USB Jumper Settings](image-url)
2.6.2 Battery Power

The LaunchPad kit can also be powered from an external battery pack by feeding the voltage on the J22 header. This input features reverse voltage protection to ensure that the board is not damaged due to an accidental reverse voltage. Perform the following steps before using the board with a battery. The board would appear as shown in Figure 17.

1. Remove the USB cable.
2. Plug in the battery pack on J22 with the correct polarity.
3. Ensure that a jumper is placed on RST_PU (J9) of the LaunchPad kit.
4. Connect a jumper across J17 and J19. This is done to supply board power from the battery.

![Figure 17. Powering the CC3220LP From Battery](image)
2.6.3 Battery Powering Only the CC3220 and U8 (Onboard Serial Flash)

In some cases, there may be a requirement to power only the CC3220 and the serial flash from the battery. The usage may not require LEDs, OPAMP for the ADC, and the sensors. In this case, the other sections can be powered off by removing the appropriate jumpers. Ensure that a jumper is placed on RST_PU (J9) of the LaunchPad kit. The board would appear as shown in Figure 18.

Figure 18. Only CC3220 and Serial Flash Powered by Battery
2.7 Isolated Current Measurement of the CC3220

To measure the current draw of the CC3220 when powering with a USB cable, use the VBAT jumper on the jumper isolation block (J19). The current measured in this mode includes only the CC3220 current and the serial flash current, and no external blocks. However, if a GPIO of the CC3220 is driving a high-current load such as an LED, then that is also included in this measurement.

2.7.1 Low-Current Measurement With USB Power (< 1 mA)

To measure the current draw of the CC3220 MCU and serial flash using an ammeter, use the VBAT jumper on the isolation block. Follow these steps to measure ultra-low power operation of the CC3220:

1. Remove the VBAT jumper (J19) in the isolation block; attach an ammeter across this jumper, as shown in Figure 19.

2. Consider the effect that the backchannel UART and any circuitry attached to the CC3220 may have on current draw. Considering disconnecting these at the isolation jumper block, or at least consider their sinking and sourcing capability in the final measurement. The CC3220 device should not drive any high-current loads directly (such as an LED) because this can draw a large current.

3. Ensure that there are no floating inputs/outputs (I/Os) on the CC3220. These cause unnecessary extra current draw. Every I/O should either be driven out or, if it is an input, should be pulled or driven to a high or low level.

4. Begin target execution and set the device to low-power modes (LPDS or hibernate).

5. Measure the current. If the current levels are fluctuating, it may be difficult to get a stable measurement. It is easier to measure quiescent states.

More information on how to experience the low-power modes and test cases of the CC3220 LaunchPad kit can be found in the CC3120, CC3220 SimpleLink™ Wi-Fi® Internet-on-a chip™ Networking Subsystem Power Management (see the Power Measurement Guide section).

NOTE: Placing the CC3220 device in shutdown mode causes an approximately 33-μA leak into the pull-up resistor (R136) on the nRESET pin. This pull-up resistor must also be removed to measure the total current below 1 μA in shutdown mode.
2.7.2 Active Power Measurements (>1 mA)

Follow these steps to measure active operation of the CC3220:

1. Remove the VBAT jumper (J19).
2. Solder a 0.1-Ω resistor on a wire, which can be connected to an oscilloscope, as shown in Figure 20. Or, attach a jumper wire between J19 so that it can be used with a current probe.

![Figure 20. Active Power Measurements (>1 mA)](image)

3. Measure the voltage across the resistor using an oscilloscope with a differential probe. (For the current probe, coil the wire around the sensor multiple times for good sensitivity.) An ammeter can also be used for this measurement, but the results may be erroneous due to the switching nature of the current.

More information on how to experience the low-power modes and test cases of the CC3220 LaunchPad kit can be found in the CC3120, CC3220 SimpleLink™ Wi-Fi® Internet-on-a chip™ Networking Subsystem Power Management (see the Power Measurement Guide section).
2.8 RF Connections

2.8.1 AP Connection Testing

By default, the board ships with the RF signals routed to the onboard chip antenna, as shown in Figure 21.

A miniature UMC connector (Murata MM8030-2610) provides a way to test in the lab using a compatible cable. Alternately, for testing the conducted measurement a U.FL connector is provided on the board. A rework must be performed before this connector can be used; this involves swapping the position of a resistor. The modified board would appear as in Figure 22.

Figure 21. Using Onboard Antenna (Default Condition)

Figure 22. Board Modified for External Antenna Connections
2.9 Assembly Drawing

Figure 23 shows the top layer assembly drawing of the CC3220x LaunchPad kit (Rev. A).

Figure 23. CC3220x LaunchPad Kit Top-Layer Assembly Drawing
2.10 Design Files

2.10.1 Hardware Design Files

All design files, including schematics, layout, Bill of Materials (BOM), Gerber files, and documentation are available for download from CC3220-LAUNCHXL-RD.

2.11 Software

All design files, including firmware patches, software example projects, and documentation are available from the CC3220 Software Development Kit.

Inside of the SDK, a set of very simple CC3220 code examples can be found that demonstrates how to use the entire set of CC3220 peripherals. When starting a new project or adding a new peripheral, these examples serve as a great starting point.

3 Development Environment Requirements

The following software examples with the LaunchPad kit require an integrated development environment (IDE) that supports the CC3220 device.

The CC3220, CC3220S, CC3220SF SimpleLink™ Wi-Fi® and Internet of Things Solution, A Single-Chip Wireless MCU programmer’s guide has detailed information about software environment setup with examples. See this document for further details on the software sample examples.

3.1 CCS IDE

CCS 6.0 or higher is required. When CCS is launched, and a workspace directory is chosen, use Project → Import Existing CCS Eclipse Project. Direct it to the desired demo project directory containing main.c.

3.2 IAR IDE

IAR 6.70 or higher is required. To open the demo in IAR, choose File → Open → Workspace…, and direct it to the *.eww workspace file inside the \IAR subdirectory of the desired demo. All workspace information is within this file.

The subdirectory also has an *.ewp project file; this file can be opened into an existing workspace, using Project → Add-Existing-Project….

4 Additional Resources

4.1 CC3220 Product Page

For more information on the CC3220 device, visit the CC3220 product page, which includes the CC3220x SimpleLink™ Wi-Fi® Wireless and Internet-of-Things Solution, a Single-Chip Wireless MCU Data Sheet and key documents such as the CC3220, CC3220S, CC3220SF SimpleLink™ Wi-Fi® and Internet-of-Things Technical Reference Manual and the http://www.ti.com/SimpleLinkWiFi-Wiki, which contains information on getting started, hardware details, software details including porting information, testing and certification, support, and the CC3220 community.

4.2 LaunchPad Development Kit Wiki

Most updated information is available on the CC3220 Wiki page.
4.3 **Download a Development Environment**

Although the files can be viewed with any text editor, more can be done with the projects if they are opened with a development environment such as Code Composer Studio (CCS), IAR, or Energia.

CCS and IAR are each available in a full version, or a free, code-size-limited version. The full out-of-box demo cannot be built with the free version of CCS or IAR (IAR Kickstart), due to the code-size limit. To bypass this limitation, a code-size-limited CCS version is provided that has most functionality integrated into a library. The code built into the library is able to be viewed by the user, but it cannot be edited. For full functionality, download the full version of each CCS or IAR.

4.4 **SimpleLink™ Academy for CC3220 SDK**

The SimpleLink™ Academy is a collection of curated training modules developed by TI subject matter experts to help developers get up and running as quickly as possible with a SimpleLink MCU device and its SDK. The training is delivered using TI Resource Explorer, which offers a powerful cloud-enabled environment that includes background information, interactive exercises, code snippets, quizzes, and more.

Experience the SimpleLink™ Academy now using the TI Resource Explorer at dev.ti.com.

![Figure 24. CC3220 SimpleLink Academy](image_url)

4.5 **Support Resources**

TI E2E™ support forums are an engineer's go-to source for fast, verified answers and design help — straight from the experts. Search existing answers or ask your own question to get the quick design help you need.

Linked content is provided "AS IS" by the respective contributors. They do not constitute TI specifications and do not necessarily reflect TI's views; see TI's Terms of Use.
**Revision History**

NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

<table>
<thead>
<tr>
<th>Changes from B Revision (August 2018) to C Revision</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Updated the Part Number and Slave Address for the temperature sensor row in Table 3 Default I²C Addresses (of Onboard Sensors)</td>
<td>14</td>
</tr>
<tr>
<td>• Added note (1) to Table 3 Default I²C Addresses (of Onboard Sensors)</td>
<td>14</td>
</tr>
<tr>
<td>• J15, J16, and J17 to J13 in Sense on Power (SOP) section</td>
<td>16</td>
</tr>
</tbody>
</table>
IMPORTANT NOTICE AND DISCLAIMER

TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATA SHEETS), DESIGN RESOURCES (INCLUDING REFERENCE DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES "AS IS" AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable standards, and any other safety, security, regulatory or other requirements.

These resources are subject to change without notice. TI grants you permission to use these resources only for development of an application that uses the TI products described in the resource. Other reproduction and display of these resources is prohibited. No license is granted to any other TI intellectual property right or to any third party intellectual property right. TI disclaims responsibility for, and you will fully indemnify TI and its representatives against, any claims, damages, costs, losses, and liabilities arising out of your use of these resources.

TI's products are provided subject to TI's Terms of Sale or other applicable terms available either on ti.com or provided in conjunction with such TI products. TI's provision of these resources does not expand or otherwise alter TI's applicable warranties or warranty disclaimers for TI products.

TI objects to and rejects any additional or different terms you may have proposed.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2022, Texas Instruments Incorporated